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dsPIC33A CURIOSITY PLATFORM
DEVELOPMENT BOARD USER’S

GUIDE
Preface
INTRODUCTION
This chapter contains general information that will be useful to know before using the 
dsPIC33A Curiosity Platform Development Board. Items discussed in this chapter 
include:
• Document Layout
• Conventions Used in this Guide
• Recommended Reading
• The Microchip Website
• Product Change Notification Service
• Customer Support
• Document Revision History

DOCUMENT LAYOUT
This user’s guide provides an overview of the dsPIC33A Curiosity Platform 
Development Board. The document is organized as follows:
• Chapter 1. “Overview” – This chapter introduces the dsPIC33A Curiosity 

Platform Development Board and provides a brief overview of its various features.
• Chapter 2. “Hardware” – This chapter describes how to program/debug the 

board using the on-board programmer and the board’s main circuit elements.
• Appendix A. “Board Layout and Schematics” – This appendix provides 

schematic diagrams for the dsPIC33A Curiosity Platform Development Board.
• Appendix B. “Bill of Materials (BOM)” – This appendix provides the component 

list used in assembling the board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our website 
(https://www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level 
of the document.

For the most up-to-date information on development tools, see the MPLAB® X IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 5
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CONVENTIONS USED IN THIS GUIDE
This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS
Description Represents Examples

Arial font:
Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...
Initial caps A window the Output window

A dialog the Settings dialog
A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK
A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>
Courier New font:
Plain Courier New Sample source code #define START

Filenames autoexec.bat
File paths c:\mcc18\h
Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-
Bit values 0, 1
Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user 

void main (void)
{ ...
}
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Preface
RECOMMENDED READING
This user’s guide describes how to use the dsPIC33A Curiosity Platform Development 
Board. The device-specific data sheets contain current information on programming 
the specific microcontroller or Digital Signal Controller (DSC) devices. The following 
Microchip documents are recommended as supplemental reference resources:
MPLAB® XC-DSC C Compiler User’s Guide (DS50003589)
This comprehensive guide describes the usage, operation and features of Microchip’s 
MPLAB XC-DSC C compiler for use with 16-bit devices.
MPLAB® X IDE User’s Guide (DS50002027)
This document describes the installation and implementation of the MPLAB X IDE 
software.

THE MICROCHIP WEBSITE
Microchip provides online support via our website at  https://www.microchip.com. This
website is used to make files and information easily available to customers. Some of
the available content includes:
• Product Support – Data sheets and errata, application notes and sample 

programs, design resources, user’s guides and hardware support documents, the 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups and a Microchip design partner 
program member listing

• Business of Microchip – Product selector and ordering guides, the latest 
Microchip press releases, a listing of seminars and events, listings of Microchip 
sales offices, distributors and factory representatives

PRODUCT CHANGE NOTIFICATION SERVICE
Microchip’s product change notification service helps keep customers current on
Microchip products. Subscribers will receive email notifications whenever there are
changes, updates, revisions or errata related to a specified product family or
development tool of interest.
To register, go to https://www.microchip.com/pcn and follow the registration 
instructions.
 2024 Microchip Technology Inc. and its subsidiaries  DS70005562A-page 7

https://www.microchip.com/pcn
https://www.microchip.com
https://www.microchip.com/pcn
https://www.microchip.com/pcn


dsPIC33A Curiosity Platform Development Board User’s Guide
CUSTOMER SUPPORT
Users of Microchip products can receive assistance through several channels:
• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support
Customers should contact their distributor, representative or ESE for support. Local 
sales offices are also available to help customers. 
A listing of sales offices and locations is included in the back of this document.
Technical support is available through the website at: 
https://www.microchip.com/support.

DOCUMENT REVISION HISTORY
Revision A (June 2024)
This is the initial release of this document.
DS70005562A-page 8  2024 Microchip Technology Inc. and its subsidiaries

https://www.microchip.com/support


dsPIC33A CURIOSITY PLATFORM
DEVELOPMENT BOARD USER’S

GUIDE
Chapter 1.  Overview
1.1 INTRODUCTION
The dsPIC33A Curiosity Platform Development Board (EV74H48A) is a full-featured 
development and demonstration platform enabling customers to explore the 
capabilities of the dsPIC33A DSC family. Board operation requires the insertion of a 
120-pin General Purpose Dual In-Line Module (DIM) containing a dsPIC33A DSC 
device (purchased separately). The board supports custom feature expansion by 
providing mikroBUS™ and Xplained Pro interfaces, allowing companion development 
boards such as QTouch® extension boards, BIST-XPRO extension kits, various 
sensors and interfaces via Click boards™ to be added. Information for supported 
companion boards is available through the website at: 
https://www.microchip.com/en-us/development-tool/EV74H48A.
The main hardware features of the board are highlighted in Figure 1-1. 

FIGURE 1-1: dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD

1. dsPIC33A Curiosity DIM Connector
2. Integrated PICkit™ On-Board 4 (PKOB4) programmer/debugger
3. 2x mikroBUS™ interfaces for hardware expansion, compatible with a wide range 

of existing Click boards™ from MikroElektronika (https://www.mikroe.com)
4. 1x Red/Green/Blue (RGB) LED
5. 3x general purpose push buttons
6. 8x general purpose green indicator LEDs
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7. MCLR Reset push button
8. 10k Ohm potentiometer
9. 2 Xplained Pro Extension Headers
10. 100 mil male header for current measurements of DIM_VDD
11. 3 on-board capacitive touch pads
12. 6 100 mil headers for choosing redundant analog measurements of capacitive 

touch pads
13. CAN/CAN-FD Driver circuit
14. 2 Channel USB Hub supporting PKOB4 programming and UART/COM channel 

simultaneously
15. 1x3 pin 100 mil male header to select between 5V external or 5V USB power
16. 5V to 3.3V LDO
17. 50 mil RMII interface
18. 3.3V to adjustable 3.3V or 5V boost
19. 9-pin 100 mil trace header
20. 2x25 pin 100 mil female interface header for all DIM connections
21. USB-C® cable connector
22. 2Mbit SQI flash memory

1.2 POWERING THE BOARD
Choose between USB or external power via the 3-pin header J25 by shunting 2 pins 
together.

1.2.1 USB Power
This board is intended to be primarily powered from the USB Micro-C® connector, J24. 
The official “USB 2.0 Specification” restricts USB applications to consume no more 
than 500 mA of USB VBUS power from the host. For applications higher than 500 mA, 
5V should be used.

1.2.2 External Power
An external +5V VDC may optionally be connected through terminal connector J26. 
Care should be taken to avoid exceeding a maximum of 6V on this input or damage to 
the 3V3 LDO may occur.

1.2.3 Boost Circuit
In addition to the on-board 3.3V and 5V nodes, there is a power plane labeled in the 
schematic as “Board_VDD.” Board_VDD utilizes the on-board boost converter to 
power the dsPIC33A General Purpose DIMs and, depending on the DIM inserted, will 
output either 3.3V or 5V. This is accomplished by connecting 
“P55_Board_VDD_SELECT” to GND through a singular DIM pin. If a DIM is designed 
with a 5V dsPIC33A device, the P55_Board_VDD_Select pin will be tied to GND and 
the boost circuit will output 5V. Otherwise, P55_Board_VDD_Select is left floating and 
the boost circuit will operate in Bypass mode, outputting 3.3V.

1.3 USING THE PROGRAMMED DEMO FIRMWARE
Each General Purpose DIM comes programmed with basic demo firmware which 
exercises several of the board hardware features, based on available pin count and 
modules for each device.
The source code for each demo can be obtained at: 
https://www.microchip.com/en-us/development-tool
DS70005562A-page 10                                2024 Microchip Technology Inc. and its subsidiaries 
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1.4 REPROGRAMMING AND DEBUGGING THE dsPIC33A DEVICE
The board has a PICkit™ On-Board (PKOB4) programmer/debugger circuit which can 
be used to program and debug any dsPIC33A target device attached through the J1 
DIM connector. Alternatively, an external programmer/debugger tool can be connected 
to the board via the 6-pin in-line connector J11 using a male-male 100 mil pitch 6-pin 
header or to the 6-pin in-line connector on the DIM itself. The PKOB4 circuit should 
automatically enumerate and be recognized by the MPLAB X IDE, v6.15 or later, when 
the dsPIC33A Curiosity Platform Development Board is connected to the host via the 
USB Micro-C connector, J24. No custom USB driver installation is necessary as the 
PKOB circuit relies on standard OS provided Human Interface Device (HID) drivers; 
therefore, the driver installation should be fully automatic. When plugged in, the PKOB 
programmer/debugger tool can be selected from the MPLAB X project properties page 
by selecting the device under: Hardware Tools>Microchip Kits>Starter Kits 
(PKOB)>Curiosity/Starter Kits (PKOB4), as shown in Figure 1-2.

FIGURE 1-2: DSPIC33A CURIOSITY PKOB TOOL SELECTION
 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 11
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GUIDE
Chapter 2.  Hardware
2.1 USING THE USB-UART INTERFACE
Two USB-UART channels are available for communication from the dsPIC® device to 
a PC via the USB connector. The MCP2221A  provides the first channel, and the 
PKOB4 provides the second. Each channel will enumerate separately and can be used 
simultaneously.

2.1.1 MCP2221A based USB-UART Channel
The board is equipped with a USB-UART interface based around the MCP2221A chip. 
The MCP2221A chip implements the standard Communication Device Class (CDC) – 
Abstract Control Model (ACM) protocol and, therefore, can use standard USB drivers 
that are provided with modern Windows®, Mac® and Linux® operating systems. Under 
most operating systems, the USB driver installation will be fully automatic. Under 
certain older operating systems, or if the device is attached to a machine running an 
operating system older than Windows 10 without an active Internet connection, manual 
installation of the drivers may be necessary. In this case, the driver package can be 
downloaded from:
https://www.microchip.com/mcp2221a
Details on how to access the serial port from Mac and Linux operating systems can also 
be found in the associated collateral for the MCP2221A. Under Windows, after a 
successful USB driver installation, the device will appear as a “COMx” port object in 
which standard serial terminal programs can open/read/write to and from.

2.1.2 PKOB4 based USB-UART Channel
Since this board has a 2-port USB hub, it can support more than one COM channel at 
a time. The second COM channel is connected through the PKOB4 directly to the USB 
connector allowing two unique UART interfaces to be utilized from the dsPIC.
To utilize this interface, configure a UART connection to nets P102_UART_PKOB_TX 
and P100_UART_PKOB_RX. All nets are named assuming the perspective of the 
dsPIC device, and the respective device infosheet should be used to determine which 
pins are designated to the USB-UART channel.

2.2 USING THE I2C BUS
Several on-board functions, including mikroBus A, mikroBus B, XPRO1 and I2C to 
USB, support I2C capability. By default, these functions are tied together on the same 
I2C bus through 0 Ohm resistors R38 and R39, as shown in Figure 2-1.
 2024 Microchip Technology Inc. and its subsidiaries   DS70005562A-page 13
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FIGURE 2-1: I2C BUS CONNECT

2.2.1 I2C Bus Connect - Populated
While connecting all features on a single bus may provide a more streamlined I2C 
experience, this also ties DIM pins P6 to P67 and P4 to P65 which limits the number of 
general purpose header pins that can be utilized at a time. 
In this configuration, the pins for the unused I2C module should be configured as digital 
inputs.

2.2.2 I2C Bus Connect - Not Populated
Removing R38 and R39 separates P6 and P67 as well as P4 and P65 into individu-
ally-controlled pins. 
This groups the features supporting I2C into two separate I2C buses. mikroBus A and 
I2C to USB are supported on one bus, and mikroBus B and XPRO1 are supported on 
the other. If all I2C-supported features are required, two separate I2C modules will 
need to be configured in the dsPIC device.

2.3 RGB LED
Every General Purpose DIM is designed to support a PWM driving signal for each 
individual color. This design allows a wide range of color options on the RGB LED.

FIGURE 2-2: RGB LED

2.4 GENERAL PURPOSE PUSH BUTTONS
The general purpose push button switches each have a pull up to Board_VDD. The 
dsPIC IO pins should be configured as digital inputs to utilize these switches. Keep in 
mind that the switch is an active-low circuit.
DS70005562A-page 14  2024 Microchip Technology Inc. and its subsidiaries



FIGURE 2-3: GENERAL PURPOSE PUSH BUTTONS

2.5 GENERAL PURPOSE GREEN INDICATOR LEDS
While the rest of the board has reference designators ordered from left to right, the 
general purpose LEDs are ordered from right to left to signify an MSB to LSB 
representation. This allows an easy display of up to 1 byte of data.

FIGURE 2-4: GENERAL PURPOSE GREEN INDICATOR LEDS

2.6 10K OHM POTENTIOMETER
The 10k Ohm potentiometer presents a simple method of providing an analog input to 
the 12-bit ADC on the dsPIC33A devices. A 20 Ohm resistor is placed between the 
potentiometer and Board_VDD, and another is placed between the potentiometer and 
VSS. This limits the voltage range that can be input to the ADC from just over VSS to 
just under Board_VDD, providing a method for detecting open and short circuit faults 
on the input voltage.

FIGURE 2-5: POTENTIOMETER
 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 15
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2.7 XPLAINED PRO EXTENSION HEADERS
The XPLAINED PRO Extension Headers allow the use of both BIST-XPRO extension 
kits and QTouch extension boards. Below is a table showing the functions supported 
on each pin.

Note: Not all dsPIC33A General Purpose DIMs will support full functionality.

TABLE 2-1: XPLAINED PRO EXTENSION HEADER SUPPORT
EXT1 DIM Pin # Pin Requirements EXT2 DIM Pin # Pin Requirements

1 15 PPS / GPIO 1 NC NC
2 GND GND 2 GND GND
3 13 Analog / PPS / GPIO 3 20 Analog
4 11 Analog / PPS / GPIO 4 22 Analog
5 9 Analog / PPS / GPIO 5 24 Analog
6 7 Analog / PPS / GPIO 6 26 Analog
7 5 Analog / PPS / GPIO 7 NC NC
8 3 Analog / PPS / GPIO 8 NC NC
9 1 Analog / PPS / GPIO 9 NC NC

10 2 Analog / PPS / GPIO 10 NC NC
11 4 I2C / PPS / GPIO 11 NC NC
12 6 I2C / PPS / GPIO 12 NC NC
13 8 NC 13 NC NC
14 10 NC 14 NC NC
15 15 Analog / PPS / GPIO 15 NC NC
16 14 Analog / PPS / GPIO 16 NC NC
17 16 Analog / PPS / GPIO 17 NC NC
18 18 Analog / PPS / GPIO 18 NC NC
19 GND GND 19 NC GND
20 Board_VDD Board_VDD 20 Board_VDD Board_VDD
DS70005562A-page 16  2024 Microchip Technology Inc. and its subsidiaries



FIGURE 2-6: XPLAINED PRO HEADERS

2.8 CAPACITIVE TOUCH PADS
The out-of-box jumper configuration allows each capacitive touch pad to be read 
redundantly from two analog channels (Figure 2-7). For functionality purposes, only 
one jumper from each pair is necessary to measure the touch pad.

FIGURE 2-7: CAPACITIVE TOUCH PADS 
 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 17
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2.9 CAN/CAN-FD DRIVER CIRCUIT
The CAN/CAN-FD driver circuit utilizes Microchip’s ATA6563 CAN interface to 
communicate through a 4-pin terminal header (J21). Installing shunts on J22 and J23 
connects a standard 120 Ohm termination between CANH and CANL.

FIGURE 2-8: CAN/CAN-FD DRIVER CIRCUIT

2.10 RMII INTERFACE
The RMII Interface allows the addition of the LAN8670-RMII Evaluation Board for 
ethernet communication and other evaluation boards of a similar type if the feature is 
available on the inserted DIM.

FIGURE 2-9: RMII INTERFACE

2.11 TRACE HEADER
The 9-pin trace header provides instruction trace capabilities if the feature is available 
on the inserted DIM.
DS70005562A-page 18  2024 Microchip Technology Inc. and its subsidiaries



FIGURE 2-10: TRACE HEADER

2.12 2MBIT SQI FLASH MEMORY
The SST26VF020A is a Quad SPI Flash® memory device (QSPI or SQI) with standard 
SPI communication availability. When in use, the device operates in SPI mode until the 
command to enable QSPI mode is sent, allowing the QSPI mode to be available at all 
times.

FIGURE 2-11: QSPI FLASH
 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 19
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Appendix A. Board Layout and Schematics
This appendix contains the jumpers, pinout, schematics and board layouts for the 
dsPIC33A Curiosity Platform Development Board. 

A.1 JUMPERS
Table A-1 shows the jumpers for the dsPIC33A Curiosity Platform Development Board Device.

TABLE A-1: JUMPERS
Jumper Description

J1 dsPIC33A Curiosity GP DIM Connector.
J2 2-pin 100 mil header used for dsPIC33A Current Measurement.

J3, J10 Two 2x25 pin 100 mil female header interfaces that can be used to connect to most DIM 
pins for general purpose use.

J4, J5, J6, J7, J8, J9 Six 100 mil headers used to determine which analog pins from the dsPIC33A connect to each 
capacitive touch pad. All six channels can be connected at once, enabling redundant analog 
measurement for each pad.

J11 Unpopulated 6-pin staggered header interface that can be used optionally to connect an 
external programmer/debugger to the target DSC. The J11 header connects to the debug 
port. The holes are slightly staggered to provide some friction retention force without requir-
ing physical soldering when a straight male-male or right angle male-male header is 
installed.

J12 9-pin 100 mil header used for Trace communication.
J13, J14 Headers used for mikroBus interface connectors A and B, respectively.

J15, J16, J19, J20 50 mil female headers used for interface with the LAN8670 RMII Evaluation Board.
J17, J18 Xplained Pro Extension Interface headers used to connect to a variety of boards.

J21 4-pin terminal connector used as the output of the CAN Driver circuit.
J22, J23 2-pin 100 mil headers that can be used as termination shunts for CANH and CANL.

J24 Micro-C USB connector. Used as a 5V power source for the board, PKOB4 programming 
and COM ports.

J25 3-pin header used to select input voltage between USB power (5V_USB) and external 
power (5V_EXT).

J26 2-pin terminal header for external 5V use.
J28 2-pin 100 mil header that can be shunted to hold PKOB4 in Reset, effectively deactivating 

the PKOB4 circuit.
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A.2 PINOUT
Table A-2 shows the pinout for the dsPIC33A Curiosity Platform Development Board device.

TABLE A-2: PINOUT

Name dsPIC33A Curiosity DIM Pin Name

P1_XPRO1_9 1 2 P2_XPRO1_10
P3_XPRO1_8 3 4 P4_mkB_B_XPRO1_SDA
P5_XPRO1_7 5 6 P6_mkB_B_XPRO1_SCL
P7_XPRO1_6 7 8 P8_XPRO1_13
P9_XPRO1_5 9 10 P10_XPRO1_14

P11_XPRO1_4 11 12 P12_XPRO1_15
P13_XPRO1_3 13 14 P14_XPRO1_16
P15_XPRO1_1 15 16 P16_XPRO1_17

NC 17 18 P18_XPRO1_18
NC 19 20 P20_XPRO2_3

P21_mkB_B_TX 21 22 P22_XPRO2_4
P23_mkB_B_RX 23 24 P24_XPRO2_5
P25_mkB_B_INT 25 26 P26_XPRO2_6

P27_mkB_B_PWM 27 28 P28_LED_0
P29_mkB_B_AN 29 30 P30_LED_1

P31_mkB_B_RST 31 32 P32_LED_2
P33_mkB_B_CS 33 34 P34_LED_3

P35_mkB_B_SCK 35 36 P36_LED_4
P37_mkB_B_MISO 37 38 P38_Cap_Touch_3R
P39_mkB_B_MOSI 39 40 P40_Cap_Touch_3

P41_S3 41 42 P42_Cap_Touch_2R
P43_S2 43 44 P44_Cap_Touch_2
P45_S1 45 46 P46_Cap_Touch_1R

P47_MCLR 47 48 P48_Cap_Touch_1
P49_PGD 49 50 P50_LED_5
P51_PGC 51 52 P52_LED_6

NC 53 54 P54_LED_7
P55_Board_VDD_Select 55 56 P56_Cap_Touch_DS

DIM_VDD 57 58 DIM_VDD
DIM_VDD 59 60 DIM_VDD

GND 61 62 GND
GND 63 64 GND

P65_mkB_A_USB_SDA 65 66 P66_POT
P67_mkB_A_USB_SCL 67 68 P68_LED_R

P69_mkB_A_TX 69 70 P70_LED_G
P71_mkB_A_RX 71 72 P72_LED_B
P73_mkB_A_INT 73 74 P74_QSPI_MOSI

P75_mkB_A_PWM 75 76 P76_QSPI_SCK
DS70005562A-page 22  2024 Microchip Technology Inc. and its subsidiaries



Board Layout and Schematics
P77_mkB_A_AN 77 78 P78_QSPI_HOLD
P79_mkB_A_RST 79 80 P80_QSPI_WP
P81_mkB_A_CS 81 82 P82_QSPI_MISO

P83_mkB_A_SCK 83 84 P84_QPSI_CS
P85_mkB_A_MISO 85 86 P86_CAN_STBY
P87_mkB_A_MOSI 87 88 P88_CAN_TXD
P89_RMII_NRST 89 90 P90_CAN_RXD
P91_RMII_IRQ 91 92 P92_GPIO

P93_RMII_MDIO 93 94 P94_GPIO
P95_RMII_MDC 95 96 P96_UART_USB_RX

P97_RMII_CRS_DV 97 98 P98_UART_USB_TX
P99_RMII_RXER 99 100 P100_UART_PKoB_RX
P101_RMII_RXD0 101 102 P102_UART_PKoB_TX
P103_RMII_RXD1 103 104 P104_TRCLK
P105_RMII_TXEN 105 106 P106_TRDAT0
P107_RMII_TXD0 107 108 P108_TRDAT1
P109_RMII_TXD1 109 110 P110_TRDAT2

P111_RMII_CLK_IN 111 112 P112_TRDAT3
DIM_VDD 113 114 DIM_VDD
DIM_VDD 115 116 DIM_VDD

GND 117 118 GND
GND 119 120 GND

TABLE A-2: PINOUT (CONTINUED)
 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 23



dsPIC
33A

 C
uriosity Platform

 D
evelopm

ent B
oard U

ser’s G
uide

D
S70005562A-page 24


 2024 M

icrochip Technology Inc. and its subsidiaries

 (PAGE 1 OF 7)

Potentiometer

2
1

3

10k
P090S
20%

R14

0.1uF
50V
0603

C5

fc = 1.4kHz at 1.1k
Thevenin Resistance

13

24

S4

330R
0603
1%

R15

1 3

2 4

S2

1 3

2 4

S1

10k
1%

R3

10k
1%

R1

Buttons

10k
1%

R51 3

2 4

S3

1k
0603
1%

R6

1k
0603
1%

R4

1k
0603
1%

R2

MCLR Reset

Board_VDD

Board_VDD

Board_VDD

Board_VDD

20R
0603
1%

R13

20R
0603
1%

R16

CE
1

SO/SIO1
2

WP/SIO2
3

VSS
4

SI/SIO0
5

SCK
6

RESET#/HOLD#/SIO3
7

VDD
8

SST26VF020A-80E/SN

U1

0.1uF
50V
0603

C10

GND

GND

GND

GND

GND

GND

GND

QSPI Flash

h Pads

1
2

3
4

5
6

DNP

J11
Board_VDD

GND

NC

ICSP Connector

Required MCLR

1k

R20

P41_S3

P43_S2

P45_S1

P47_MCLR

P47_MCLR

P49_PGD
P51_PGC

p_Touch_DS

P66_POT

P74_QSPI_MOSI

P76_QSPI_SCK
P78_QSPI_HOLD

P80_QSPI_WP
P82_QSPI_MISO

P84_QSPI_CS

3V3

3V3

L

A

Pull DIMUp is on
A.3 dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD SCHEMATICS
Figure A-1 through Figure A-7 show the board schematics. 

FIGURE A-1: dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD SCHEMATICS, REV. 4.0
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FIGURE A-3:  dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD SCHEMATICS, REV. 4.
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A.
4 DSPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD LAYOUT, REV. 4.0



dsPIC33A Curiosity Platform Development Board User’s Guide
A.5 dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD PCB LAYOUT
The dsPIC33A Curiosity Platform Development Board is a four-layer FR4, 1.6 mm, Plated-Through-Hole 
(PTH) PCB construction. Figure A-8 and Figure A-9 illustrate the PCB layers.

FIGURE A-8: dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD TOP SILKSCREEN AND 
TOP COPPER
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Board Layout and Schematics
FIGURE A-9: dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD BOTTOM 
SILKSCREEN AND BOTTOM COPPER

Bottom Silkscreen

Bottom Copper
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dsPIC33A CURIOSITY PLATFORM
DEVELOPMENT BOARD USER’S

GUIDE
Appendix B. Bill of Materials (BOM)
This appendix contains the Bill of Materials (BOMs) for the dsPIC33A Curiosity 
Platform Development Board.

B.1 BILL OF MATERIALS – dsPIC33A CURIOSITY PLATFORM DEVELOPMENT 
BOARD

Table B-1 shows the Bill of Materials for the dsPIC33A Curiosity Platform Development 
Board.

TABLE B-1: dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD BOM

Qty Designator Description Manufacturer Manufacturer Part # 

9 _J2, _J4, _J5, _J6, 
_J7, _J8, _J9, _J25, 
_J28

MECH HW JUMPER 2.54mm 
1x2

Sullins Connector Solu-
tions

SSC02SYAN

10 C1, C4, C5, C7, C9, 
C10, C11, C12, C13, 
C17

CAP CER 0.1uF 50V 10% X7R 
SMD 0603

Yageo Corporation CC0603KRX7R9BB104

4 C2, C3, C6, C8 CAP CER 22uF 25V 20% X5R 
SMD 0805

Samsung CL21A226MAYNNNE

4 C14, C15, C16, C18 CAP CER 1uF 16V 10% X7R 
SMD 0603

Taiyo Yuden EMK107B7105KA

2 C19, C20 CAP CER 0.1uF 50V 10% X7R 
SMD 0805

Samsung CL21B104KBCNNNC

1 C21 CAP TANT 22uF 25V 10% 
0.8Ohm SMD D

KEMET T491D226K025AT

1 C22 CAP CER 4700pF 100V 10% 
X7R SMD 0603 AEC-Q200

TDK Corporation CGA3E2X7R2A472K080AA

33 C23, C24, C25, C26, 
C27, C28, C29, C30, 
C32, C35, C37, C48, 
C49, C50, C53, C54, 
C56, C57, C58, C59, 
C60, C61, C62, C63, 
C64, C65, C66, C67, 
C68, C69, C70, C71, 
C72

CAP CER 0.1uF 25V 10% X7R 
SMD 0402

TDK Corporation C1005X7R1E104K050BB

1 C33 CAP CER 10uF 25V 10% X5R 
SMD 0805

Murata Electronics ® GRM21BR61E106KA73L

2 C34, C41 CAP CER 47uF 10V 20% X5R 
0805

Murata Electronics GRM21BR61A476ME15K

1 C36 CAP CER 0.022uF 16V 10% 
X7R SMD 0402

Yageo Corporation CC0402KRX7R7BB223

4 C38, C40, C51, C52 CAP CER 4.7uF 16V 10% X5R 
SMD 0603

TDK Corporation C1608X5R1C475K080AC
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1 C39 CAP CER 1000pF 50V 10% 
X7R SMD 0402

Murata Electronics GCM155R71H102KA37D

4 C42, C43, C44, C45 CAP CER 22uF 10V 20% X5R 
SMD 0805 >50%C_at_3V3

Taiyo Yuden LMK212BBJ226MG-T

2 C46, C47 CAP CER 1uF 10V 10% X5R 
SMD 0402

Samsung CL05A105KP5NNNC

1 C55 CAP CER 10000pF 16V 10% 
X7R SMD 0402

KEMET C0402C103K4RACTU

2 D3, D4 DIO TVS BIDIR  PGB101 SMD 
0402

Littelfuse ® PGB1010402KR

1 FB1 FERRITE 2A 220R SMD 0805 Murata Electronics ® BLM21PG221SN1D

2 FB2, FB3 FERRITE 2A 600R SMD 0805 TDK Corporation MPZ2012S601AT000

1 J1 CON EDGE HTEC8 0.80mm 
120P Female SMD VERT

Samtec HTEC8-160-01-L-DV-A-K-TR

10 J2, J4, J5, J6, J7, J8, 
J9, J22, J23, J28

CON HDR-2.54 Male 1x2 Gold 
5.84MH TH VERT

Multicomp SPC SPC20481

2 J3, J10 CON HDR-2.54 Female 2x25 
Tin TH VERT

Samtec SSW-125-01-F-D

1 J12 CONN HEADER VERT 
10POS 2.54MM

Samtec TSW-105-07-L-D-010

2 J13, J14 SOCKET mikroBUS HOST 
DIP 16 TH

Sullins Connector Solu-
tions

PPTC081LFBN-RC

2 J15, J16 CON STRIP-1.27 Female 1x3 
Gold TH VERT

Samtec SLM-103-01-L-S

2 J17, J18 CON HDR-2.54 Male 2x10 
Rotated 180Degrees Gold TH 
RT ANGLE

Sullins Connector Solu-
tions

PBC10DBAN

2 J19, J20 CON STRIP-1.27 Female 1x12 
Gold TH VERT

Samtec SLM-112-01-L-S

1 J21 CON TERMINAL 2.54mm 1x4 
Female 20-30AWG 6A TH R/A

On-Shore Technology OSTVN04A150

1 J24 CON USB3.0 TYPE-C 
FEMALE SMD R/A

Advanced-Connectek 
Inc.

NBR25-AK5322

1 J25 CON HDR-2.54 Male 1x3 Gold 
5.84MH TH VERT

Amphenol 
Communications 
Solutions

68000103HLF

1 J26 CON TERMINAL 2.54mm 1x2 
Female 20-30AWG 6A TH R/A

Phoenix Contact 1725656

1 L2 INDUCTOR 1uH 0.8A 20% 
SMD 0805

Murata Electronics LQM21PN1R0MC0D

11 LED0, LED1, LED2, 
LED3, LED4, LED5, 
LED6, LED7, LED9, 
LED11, LED12

DIO LED GREEN 2V 30mA 
35mcd Clear SMD 0603

Vishay ® Lite-On LTST-C190KGKT

1 LED8 DIO LED TRI RED, GREEN, 
BLUE 2.1V, 3.0V, 3.2V 50mA, 
35mA, 35mA SMD 6-PLCC

Cree LED ® CLX6F-FKC-CNP1ST1E
1BB7D3D3

2 LED10, LED13 DIO LED YELLOW 2.1V 20mA 
6mcd Clear SMD 0603

Vishay Lite-On LTST-C190YKT
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1 Q1 TRANS FET P-CH 
DMP3099LQ-7 -30V -3.8A 
1.08W SOT-23-3

Diodes Incorporated ® DMP3099LQ

1 Q2 TRANS FET N-CH 
2N7002NXBKR 60V 270mA 
2.8R 0.4W SOT23-3

Nexperia 2N7002NXBKR

3 R1, R3, R5 RES TKF 10k 1% 1/10W SMD 
0603

NIC Components Corp ® NRC06F1002TRF

15 R2, R4, R6, R7, R8, 
R9, R20, R26, R27, 
R28, R29, R30, R31, 
R32, R33

RES TKF 1k 1% 1/10W SMD 
0603

Stackpole Electronics, 
Inc.

RMCF0603FT1K00

1 R10 RES TKF 100R 1% 1/10W 
SMD 0603 AEC-Q200 (Use 
RSMT0696)

Yageo Coporation AC0603FR-07100RL

5 R12, R38, R39, R40, 
R41

RES TKF 0R 1/10W SMD 
0603

Stackpole Electronics, 
Inc.

RMCF0603ZT0R00

2 R13, R16 RES TKF 20R 1% 1/10W SMD 
0603

Panasonic ® ERJ-3EKF20R0V

1 R14 RES VARIABLE 10k 20% TH 
P090S

TT Electronics / BI Tech-
nologies

P090S-14T20BR10K

5 R15, R17, R18, R50, 
R52

RES TKF 330R 1% 1/10W 
SMD 0603

Stackpole Electronics, 
Inc.

RMCF0603FT330R

1 R19 RES TKF 180R 1% 1/10W 
SMD 0603

Yageo Corporation RC0603FR-07180RL

4 R34, R35, R36, R37 RES TKF 2k 1% 1/10W SMD 
0603

Stackpole Electronics, 
Inc.

RMCF0603FT2K00

2 R42, R43 RES TKF 60.4R 1% 1/4W 
SMD 1206

Yageo Corporation RC1206FR-0760R4L

4 R44, R45, R75, R84 RES TKF 100k 1% 1/10W 
SMD 0402 AEC-Q200

KOA Speer Electronics, 
Inc.®

RK73H1ETTP1003F

8 R46, R58, R61, R63, 
R71, R73, R76, R103

RES TKF 10k 1% 1/10W SMD 
0402

Panasonic ERJ-2RKF1002X

2 R49, R51 RES TKF 15R 1% 1/16W SMD 
0603

Stackpole Electronics, 
Inc.

RMCF0603FT15R0

3 R53, R54, R69 RES TKF 470R 1% 1/16W MF 
0402

Yageo Corporation RC0402FR-07470RL

3 R55, R56, R57 RES TKF 56k 1% 1/16W SMD 
0402

Rohm Semiconductor MCR01MZPF5602

2 R62, R67 RES TKF 5.11k 1% 1/10W 
SMD 0402 AEC-Q200

KOA Speer Electronics, 
Inc.

RK73H1ETTP5111F

1 R64 RES TKF 442k 1% 1/16W 
SMD 0402

Samsung RC1005F4423CS

1 R65 RES TKF 95.3k 1% 1/16W 
SMD 0402 AEC-Q200

Yageo Corporation AC0402FR-0795K3L

1 R66 RES TKF 24.3k 1% 1/16W 
SMD 0402

Samsung RC1005F2432CS

2 R68, R83 RES TKF 5.62k 1% 1/16W 
SMD 0402

Vishay / Dale CRCW04025K62FKED
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2 R70, R85 RES TKF 31.6k 1% 1/10W 
SMD 0402

Panasonic ERJ-2RKF3162X

4 R72, R86, R100, R101 RES TKF 47k 5% 1/10W SMD 
0402

Panasonic ERJ-2GEJ473X

1 R74 RES TF 2.2k 1% 1/10W SMD 
0603 AEC-Q200

Stackpole Electronics, 
Inc.

RMCF0603FT2K20

1 R77 RES TKF 1M 1% 1/10W SMD 
0402

Panasonic ERJ-2RKF1004X

1 R78 RES TF 910k 0.1% 1/16W 
SMD 0603

TE Connectivity CPF0603B910KE1

1 R79 RES TKF 487K 1% 1/10W 
SMD 0402

Panasonic ERJ-2RKF4873X

1 R80 RES TKF 340k 1% 1/10W 
SMD 0402

Panasonic ERJ-2RKF3403X

4 R81, R82, R92, R96 RES TKF 4.7k 1% 1/16W SMD 
0402

Yageo Corporation RC0402FR-074K7L

9 R87, R88, R89, R90, 
R91, R94, R95, R97, 
R102

RES TKF 330R 1% 1/16W 
SMD 0402

Yageo Corporation RC0402FR-07330RL

2 R93, R98 RES TKF 3.3k 1% 1/10W SMD 
0402

Panasonic ERJ-2RKF3301X

4 S1, S2, S3, S4 SWITCH TACT SPST 12V 
50mA PTS645SM43SMTR92 
LFS SMD

C&K Switches ® PTS645SM43SMTR92LFS

5 TP1, TP2, TP3, TP4, 
TP5

CON TP LOOP Black TH Keystone Electronics ® 5011

1 U9 IC SWITCH SPDT 
74LVC1G3157 SC-70-6

Rochester Electronics ® SN74LVC1G3157DCKR

4 U11, U12, U13, U14 IC TRANSCEIVER 
74LVC1T45GM or 
74LVC1T45GW Single Bit Volt-
age Translator SOT-886 
SOT-363 Dual FP

Nexperia 74LVC1T45GM,115

Microchip Parts listed below
1 U1 MCHP MEMORY SERIAL 

FLASH 16M 104MHz 
SST26VF020A-80E/SN 
SOIC-8

Microchip Technology SST26VF020A-80E/SN

1 U2 MCHP INTERFACE CAN 
ATA6563-GAQW1 SOIC-8

Microchip Technology ATA6563-GAQW1

1 U3 MCHP INTERFACE USB 
I2C/UART MCP2221A-I/ML 
QFN-16

Microchip Technology MCP2221A-I/ML

1 U4 MCHP INTERFACE USB 2.0 
HS 2 PORT HUB CTRLR 
QFN-24 USB2422-I/MJ

Microchip Technology USB2422-I/MJ

1 U5 MCHP ANALOG POWER 
SWITCH 5.5V 3A 
MIC2042-1YTS TSSOP-14

Microchip Technology MIC2042-1YTS

1 U6 MCHP ANALOG LDO 3.3V 
MCP1727-3302E/MF

Microchip Technology MCP1727-3302E/MF
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1 U7 MCHP ANALOG SWITCHER 
Boost 3V to 5.5V 
MIC2877-AYFT-TR FTQFN-8

Microchip Technology MIC2877-AYFT-TR

1 U8 MCHP MCU 32-BIT 300MHz 
2MB 384kB 
ATSAME70N21B-ANT 
LQFP-100

Microchip Technology ATSAME70N21B-ANT

1 U10 MCHP MEMORY SERIAL 
EEPROM 256k I2C 
24LC256T-E/ST TSSOP-8

Microchip Technology 24LC256T-E/ST

1 Y1 MCHP OSC MEMS DSC6011-
JI2B-024.0000_2.5LX2.0WX0.
89H_LGA

Microchip Technology DSC6011JI2B-024.0000

1 Y2 MCHP CLOCK OSCILLATOR 
SINGLE 12.000MHZ 
DSC6011JI1B-012.0000 VLGA

Microchip Technology DSC6011JI1B-012.0000

Mechanical Parts to be added in the package

1 LABEL1 LABEL PCBA 18x6mm Data-
matrix Assy# / Rev / Serial / 
Date

ACT Logimark AS ® 505462

8 PAD1, PAD2, PAD3, 
PAD4, PAD5, PAD6, 
PAD7, PAD8

MECH HW RUBBER PAD 
Cylindrical flat top D8H2.8 
Black

3M™ SJ5076BLACK

PCB

1 PCB1 Printed Circuit Board 04-11931-R3
Do Not Populate Parts listed below

2 D1, D2 DIO TVS PESD1IVN27-AX 
45V 3A SOD-323

Nexperia PESD1IVN27-AX

1 J11 CON HDR-2.54 Male 1x6 
Staggered DNP

Sullins Connector Solu-
tions

PBC36SAAN

1 J27 CON HDR-1.27 Male 1x2 Gold 
TH VERT

Harwin M50-3530242

1 L1 CM CHOKE 5.1k@10MHz 
1.5R SMD 1210 AEC-Q200

TDK Corporation ACT1210D-101-2P-TL00

1 R11 RES TKF 0R 1/10W SMD 
0603

Stackpole Electronics, 
Inc.

RMCF0603ZT0R00

2 R59, R60 RES TKF 15R 1% 1/16W SMD 
0603

Stackpole Electronics, 
Inc.

RMCF0603FT15R0
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Note the following details of the code protection feature on Microchip products:
• Microchip products meet the specifications contained in their particular Microchip Data Sheet.

• Microchip believes that its family of products is secure when used in the intended manner, within operating specifications, and 
under normal conditions.

• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code protection features of 
Microchip product is strictly prohibited and may violate the Digital Millennium Copyright Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code protection does not 
mean that we are guaranteeing the product is "unbreakable" Code protection is constantly evolving. Microchip is committed to 
continuously improving the code protection features of our products.
This publication and the information herein may be used only
with Microchip products, including to design, test, and integrate
Microchip products with your application. Use of this informa-
tion in any other manner violates these terms. Information
regarding device applications is provided only for your conve-
nience and may be superseded by updates. It is your responsi-
bility to ensure that your application meets with your
specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at https://
www.microchip.com/en-us/support/design-help/client-support-
services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS".
MICROCHIP MAKES NO REPRESENTATIONS OR WAR-
RANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED,
WRITTEN OR ORAL, STATUTORY OR OTHERWISE,
RELATED TO THE INFORMATION INCLUDING BUT NOT
LIMITED TO ANY IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A
PARTICULAR PURPOSE, OR WARRANTIES RELATED TO
ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDI-
RECT, SPECIAL, PUNITIVE, INCIDENTAL, OR CONSE-
QUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY
KIND WHATSOEVER RELATED TO THE INFORMATION OR
ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS
BEEN ADVISED OF THE POSSIBILITY OR THE DAMAGES
ARE FORESEEABLE. TO THE FULLEST EXTENT
ALLOWED BY LAW, MICROCHIP'S TOTAL LIABILITY ON
ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION
OR ITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF
ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP
FOR THE INFORMATION. 

Use of Microchip devices in life support and/or safety applica-
tions is entirely at the buyer's risk, and the buyer agrees to
defend, indemnify and hold harmless Microchip from any and
all damages, claims, suits, or expenses resulting from such
use. No licenses are conveyed, implicitly or otherwise, under
any Microchip intellectual property rights unless otherwise
stated.
 2024 Microchip Technology Inc. and its subsidiaries  

For information regarding Microchip’s Quality Management Systems, 
please visit www.microchip.com/quality.
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